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INTRODUCTION 

HOW DOES PHOTOMAPPER DESKTOP 10 HELP ME WITH MY WORK? 

Images say more than words. But how can I organize picture libraries with thousands of digital photos? 

The solution is linking images with the position where they were taken using the GPS-capable digital camera 

G700SE and Caplio 500 SE from Ricoh, with integrated or extern GPS and the software PhotoMapper Desktop 

10. 

In many fields of application of object documentation and management, geo referencing of takings is 

absolutely necessary. Up to now, this had to be carried out in a time-consuming post-processing, which now 

becomes superfluous. Already when the picture is taken, the site coordinates are determined with GPS and 

saved in the picture's header. 

PhotoMapper Desktop 10 enables you to make use of this information and embed it in the geographic 

information system ArcGIS from ESRI. The GIS-user can simply access the photos and manage them without any 

major effort. The Thumbnail Viewer facilitates finding photos with preview images, makes it possible to zoom 

in on a selected photo and marks pictures without position data. 

Older data inventories can be referenced retroactively with PhotoMapper Desktop 10. 

 

ESRI's ArcMap with PhotoMapper Desktop 10 extension 

The possible applications are manifold, reaching from disaster control ς where staff members can document 

the situation exactly on the spot with marks of time and location, making it thus possible for the control center 
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to literally get a picture of the situation ς to classical documentation functions in environmental protection or 

object documentation, e.g. in real estate business, tourism industry or for police and Health and Safety.  

PhotoMapper Desktop 10 ƛǎ ŀƴ ŜȄǘŜƴǎƛƻƴ ŦƻǊ 9{wLΩǎ !ǊŎDL{ 10 and cannot be used as a stand alone module.  

Because of the implementation of the File-Based Geodatabase, the latest version PhotoMapper Desktop 10 is 

only executable under ArcGIS 10! 

OPERATIONS LAYOUT 

First switch on the GPS device and your camera. For the initial startup, please observe the short instruction in 

the appendix. 

Take photos with the G700SE / Caplio 500SE from Ricoh. With the pluggable GPS or an extern Bluetooth GPS, 

the exact time of taking and the geographic coordinates are saved automatically. 

First load the digital images from the camera onto your PC and save the data on the hard disk. You can link the 

camera to your PC with the provided USB cable or use the W-LAN functionality of the camera. 

With PhotoMapper Desktop 10 you can access all digital pictures and work with them in the geographic 

information system ArcGIS 9.2. 

In order to do this, a reference is written into a File-Based Geodatabase, Personal Geodatabase or in a file in 

the Shapefile format. This reference can either be relative or absolute. 

From the coordinates of the location of the taking, a point layer is created. The pictures are linked with these 

taking points. 

Besides, an annotation group can be created with the pictures, whose characteristics can be defined by the 

user. 
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INSTALLATION AND LICENSING 

SYSTEM REQUIREMENTS 

 

Operating system Windows 2000, NT, XP, Vista, 7 

GIS Software ESRI ArcGIS 10 (ArcView, ArcEditor or ArcInfo). 

The extension does not work with prior versions of ArcGIS 

Free disc space about 30 MB  for PhotoMapper Desktop 10 

INSTALLATION 

Please make sure you have administrator rights which are necessary for the installation. 

1. Start the MSI file with a double click. 

2. Read the license agreement and accept it. 

3. Select a folder for the program. 

Follow up the further instructions of the setup. If any problems have occurred, please contact the technical 

support of alta4 Geoinformatik AG. 

When starting the PhotoMapper Desktop 10, you can load your licensing file. Read the next chapter for more 

information. 

LOADING IN ARCMAP 

1. Start the software ArcMap. 

2. {ŜƭŜŎǘ ǘƘŜ ƻǇǘƛƻƴ ά9ȄǘŜƴǎƛƻƴǎά ƛƴ ǘƘŜ Ϧ¢ƻƻƭǎϦ ƳŜƴǳΦ 

3. Activate the checkbox for PhotoMapper Desktop 10. 

3.1. If the PhotoMapper Desktop 10 toolbar does not appear automatically, you can display it manually. In 

ƻǊŘŜǊ ǘƻ Řƻ ǘƘƛǎΣ ǎŜƭŜŎǘ ά¢ƻƻƭōŀǊǎέ ƛƴ ǘƘŜ ά±ƛŜǿέ ƳŜƴǳ ŀƴŘ ŀŎǘƛǾŀǘŜ ϦPhotoMapper Desktop 10 

¢ƻƻƭōŀǊέΦ 

 

PhotoMapper Desktop 10 Toolbar 

  

http://www.alta4.com/eng/products_e/esri/index.htm
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UNINSTALLING 

GPS Photo Mapper can be uninstalled like any other Windows software using the control panel. 

1. First of all, end ArcGIS. 

2. ¢ƘŜƴ ƻǇŜƴ ǘƘŜ ²ƛƴŘƻǿǎ {ǘŀǊǘ aŜƴǳ ŀƴŘ ŎƘƻƻǎŜ ά{ŜǘǘƛƴƎǎέ Ҕ ά/ƻƴǘǊƻƭ tŀƴŜƭέ Ҕ ά{ƻŦǘǿŀǊŜέΦ 

3. Select PhotoMapper Desktop 10 ŦǊƻƳ ǘƘŜ ƭƛǎǘ ŀƴŘ ŎƭƛŎƪ ƻƴ ά/ƘŀƴƎŜκwŜƳƻǾŜέ. 

LICENSING 

After purchasing a commercial license, you can convert the software to the full version with all functions 

without a new installation. As soon as you start ArcMap with a PhotoMapper Desktop 10 demo version, the 

following window opens: 

 

Registration 

Click άŎƘŀƴƎŜ ƭƛŎŜƴǎŜέ ǘƻ ƭƻŀŘ ȅƻǳǊ ƭƛŎŜƴǎƛƴƎ ŦƛƭŜ όϝΦƭƛŎύ ŀƴŘ ŎƘŀƴƎŜ ǘƻ ŀ ŎƻƳƳŜǊŎƛŀƭ ƭƛŎŜƴǎŜ ǿƛǘƘ Ŧǳƭƭ ŦǳƴŎǘƛƻƴŀƭ 

range. 
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WHAT'S NEW? 

WHAT'S NEW IN PHOTOMAPPER DESKTOP 10? 

The change to the modern .net-technology is not the only thing that is new. With revised control elements, the 

new PhotoMapper Desktop 10 has clearly gained more clarity and usability. Besides, the developers tie up to 

the standard of ArcGIS 9.2 with the new data format File-Based Geodatabase. 

The data management and photo handling in the Table of Content have been facilitated considerably. The 

photo display with MouseOver functionality and the tool control with a context menu facilitate the handling 

and make it more intuitive. 

NEW USER INTERFACE 

The entire graphical interface has been reworked and the control elements have been simplified and reduced 

in number. The tool bar now only contains three elements. The program is largely controlled through windows 

context menus, which makes handling very simple and intuitive. 

 

  

 

ADD PHOTOS BY DRAG & DROP 

The image management in PhotoMapper Desktop 10 is automatic. Photos can simply be added to ArcMap 

using drag & drop. In order to do this, select the photos in any file explorer and then drag them into the 

Thumbnail Viewer of the PhotoMapper Desktop 10. By erasing a picture in the Thumbnail Viewer, the complete 

dataset is removed. 
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Drag&Drop 

DISPLAY OF THE PHOTOS BY MOUSEOVER FUNCTION 

The new MouseOver function makes working with the map even faster and more comfortable. When moving 

the mouse over the location of a picture in the map, the images are displayed dynamically. 

ADOPTING ATTRIBUTE DATA SELECTIVELY OUT OF THE EXIF HEADER 

The EXIF header of a picture contains much information, not all of which is needed by every user or for every 

project. For the sake of clarity, PhotoMapper Desktop 10 makes it possible to select the exif tags to be adopted 

during the data import. 
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FILE-BASED GEODATABASE INSTEAD OF PERSONAL GEODATABASE 

The storage format used by PhotoMapper Desktop 10 is the File-Based Geodatabase introduced with ArcGIS 

9.2. Unlike the Access-based Personal Geodatabase used up to now, the File-Based Geodatabase is set in a file 

structure, which means, the File-Based Geodatabase is a directory in which the data layers are saved as files. 

 

File-GeoDatabase in ArcCatalog 
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The new data format offers a higher performance, does not depend on the operating system and allows a 

much bigger file size than the Personal Geodatabase. Besides, it is possible to compress and encode the files. 

The Personal Geodatabase continues to be supported. 

ADDING PHOTOS TO EXISTING FILE-BASED GEODATABASES 

The EXIF header of a picture contains much information, not all of which is needed by every user or for every 

project. For the sake of clarity, the PhotoMapper Desktop 10 makes it possible to select the data fields to be 

adopted during the data import. 

WHAT'S NEW IN PHOTOMAPPER DESKTOP 10? 

PhotoMapper Desktop 10 has been structurally improved in many respects. This has led to a considerable gain 

in performance. Remarkable features have joined the well-known functions. 

DIRECTION INDICATOR 

Through the compass module of the Ricoh G700SE / Caplio 500 SE, there are now 2 directional values included 

in the EXIF area. Just like before, the direction of movement is recorded and stored in the image file. A new 

feature is the direction ascertained by the compass. This directional value indicated the exaction direction in 

which the picture was taken. Through the expanded settings, PhotoMapper Desktop 10 enables you to use the 

compass direction as well as the direction of moving for the images' display of direction. This is especially 

important when photographing with cameras which do not dispose of the compass module yet. 

PDF PHOTO REPORT 

Through its Wizard functionality, his tool offers a comfortable and fast possibility of exporting your photos 

including the attributes you want to in an appealing layout as a PDF file. Through the universal character of the 

PDF format, the data transfer is no longer a problem. 
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THUMBNAIL CACHE 

PhotoMapper Desktop 10 v. 4.1.1 introduced a thumbnail cache function for a faster access to already 

compiled image layers. During the import process a cache will be built which will then be accessed by 

PhotoMapper Desktop 10 as soon as you want to load your images again. You yourself define where the cache 

will be created and how much storage capacity is allocated. You may modify the settings by selecting Menu > 

Tools > Options > Thumbnail Cache from the menu. 

 

Define the storage location and capacity of your thumbnail cache 

GPS TRACK IMPORT 

PhotoMapper Desktop 10 now offers the possibility of importing tracklogs in different formats and display 

them as line features. Additional import settings concerning the arrangement of the line feature facilitate later 

use. 
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Example for the import of a gps track 

SAVING LOCATION INFORMATION IN THE PHOTOS 

PhotoMapper Desktop 10 allows you to locate not georeferenced photos later and write back the position 

inormation in the EXIF section of the photos. This location information will remain independent from the GIS 

layer. When sharing the photos with others, now you just need to pass the photos. The position is already 

included in the photo itself.  

INTEGRATION OF PHOTOMAPPER SERVER LAYER 

With version 4.1.1 the possibility of integrating photos from PhotoMapper Server is implemented. wurde die 

Möglichkeit geschaffen Photos aus PhotoMapper Server (v. 1.1.7 and above) zu integrieren. Also read 

"Integration of PhotoMapper Server layer in ArcMap" on page 36. 
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FUNCTION DESCRIPTION 

GEODATABASES 

FILE-BASED GEODATABASE 

With ArcGIS 9.2, ESRI has introduced a new Geodatabase: the File-Based Geodatabase. 

Unlike the Access-based Personal Geodatabase used up to now, the File-Based Geodatabase is set in a file 

structure, which means, the File-Based Geodatabase is a directory in which the data layers are saved as files. 

The advantages over the Personal Geodatabase are the higher performance, the independence of an operating 

system, the possibility to compress and encrypt the contents and the bigger maximum file size. 

For the future, ESRI recommends using the File-Based Geodatabase rather than the Personal Geodatabase. 

PERSONAL GEODATABASE 

The previous version of PhotoMapper Desktop 10 used the Personal Geodatabase as storage format. This 

Access-based geodatabase continues to be supported by PhotoMapper Desktop 10. If you would like to import 

the Feature Classes of your old databases from the previous version, read paragraph "Import from 

PhotoMapper Desktop 10 2.0". 

CREATE A NEW FILE-BASED GEODATABASE 

In order to create a new File-Based Geodatabase in PhotoMapper Desktop 10Σ ǎŜƭŜŎǘ άbŜǿ CƛƭŜ-Based 

DŜƻŘŀǘŀōŀǎŜέ ŦǊƻƳ ǘƘŜ άCƛƭŜέ ƳŜƴǳΦ  

Enter the directory where the geodatabase is to be stored. 

Then a feature class can directly be created in this database. Enter a name for it. 

 

ADD A NEW FEATURE CLASS TO AN EXISTING FILE-BASED GEODATABASE 

If you would like to create an additional feature class within an existing File-.ŀǎŜŘ DŜƻŘŀǘŀōŀǎŜΣ ǎŜƭŜŎǘ ά!ŘŘ 

new feature class to existing File-.ŀǎŜŘ DŜƻŘŀǘŀōŀǎŜέ ƛƴ ǘƘŜ άCƛƭŜέ ƳŜƴǳΦ CƛǊǎǘ ƻǇŜƴ ǘƘŜ ŘŜǎƛǊŜŘ ŘŀǘŀōŀǎŜΣ ŀƴŘ 

then enter a name for the feature class. 
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OPEN FEATURE CLASS OF AN EXISTING GEODATABASE 

In order to use a feature class, for instance from another PhotoMapper Desktop 10 project, load it in the menu 

with άCƛƭŜέ Ҕ άhǇŜƴ ŦŜŀǘǳǊŜ Ŏƭŀǎǎέ. First select the geodatabase (File-Based Geodatabase or Personal 

Geodatabase) and then the feature class. 

SHAPEFILE  

The popular file format ESRI Shapefile, which contains only one feature class, is also offered as a means of 

storing your data. 

With άaŜƴǳέ Ҕ άCƛƭŜέ Ҕ άbŜǿ {ƘŀǇŜŦƛƭŜέ ȅƻǳ ŎǊŜŀǘŜ ŀ ŦƛƭŜ ƛƴ ǘƘŜ {ƘŀǇŜŦƛƭŜ ŦƻǊƳŀǘ ŀǎ ŀ ƭŀȅŜǊΦ 

IMPORT FROM GPS PHOTOMAPPER 2.0 

In order to continue working with your old files in PhotoMapper Desktop 10, you can import your old 

inventory. 

Wǳǎǘ ŎƭƛŎƪ ƻƴ άLƳǇƻǊǘ tƘƻǘƻaŀǇǇŜǊ ǾнΦл CŜŀǘǳǊŜ /ƭŀǎǎέ ƛƴ ǘƘŜ άCƛƭŜέ ƳŜƴǳΦ 

In PhotoMapper Desktop 10 2.0 feature classes were saved in a Personal Geodatabase. So first select the 

database file (*.mdb) from the file dialog and then the feature class. 
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Then select the File-Based Geodatabase where you would like to save the imported feature class and enter a 

name for it. 

 

LOADING THE DIGITAL PICTURES IN ARCMAP 

Start ArcMap. For a better visualization we recommend opening a background map containing the location 

ǿƘŜǊŜ ȅƻǳǊ ǇƛŎǘǳǊŜǎ ǿŜǊŜ ǘŀƪŜƴΦ CƻǊ ǘƘƛǎ ǇǳǊǇƻǎŜΣ ƻǇŜƴ ŦƻǊ ƛƴǎǘŀƴŎŜ ά{ŜŀǊŎƘ ŦƻǊ ƳŀǇǎέ ƛƴ ǘƘŜ ǎǘŀǊt window and 

open a map from your hard disk. If the PhotoMapper Desktop 10 tool bar or the PhotoMapper Desktop 10 

window is not displayed, load them as described in paragraph έ[ƻŀŘƛƴƎ ƛƴ !ǊŎaŀǇέΦ 

Select the feature class of a geodatabase or a Shapefile with the selection menu in the menu bar. You must 

ƘŀǾŜ ŎǊŜŀǘŜŘ ƻǊ ƭƻŀŘŜŘ ǘƘŜǎŜ ŦŜŀǘǳǊŜ ŎƭŀǎǎŜǎ ōŜŦƻǊŜΣ ŀǎ ŘŜǎŎǊƛōŜŘ ƛƴ ǇŀǊŀƎǊŀǇƘ  άDŜƻŘŀǘŀōŀǎŜǎέΦ 
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LOADING INDIVIDUAL PICTURES 

In order to load your pictures in ArcMapΣ ŎƭƛŎƪ ƻƴ άCƛƭŜέ Ҕ ά!ŘŘ ǇƘƻǘƻǎέ ƛƴ ǘƘŜ ƳŜƴǳ ƻŦ ȅƻǳǊ  

PhotoMapper Desktop 10 window. Now select the directory where your pictures were saved. Now you can 

open an individual picture ς or several, if you have selected more thaƴ ƻƴŜ ǿƛǘƘ ǘƘŜ ά/ǘǊƭέ ōǳǘǘƻƴ ǇǊŜǎǎŜŘ. 

 

The photos are added to the selected feature class. A loading bar represents the current progress. 

LOADING ENTIRE FOLDERS 

In the PhotoMapper Desktop 10 window, in the menu ǳƴŘŜǊ άCƛƭŜέ Ҕ ά!ŘŘ ǇƘƻǘƻǎ ŦǊƻƳ ŦƻƭŘŜǊέ ȅƻǳ Ŏŀƴ ƻǇŜƴ ŀƭƭ 

pictures from one folder. If you would like to open the photos in the subdirectories as well, confirm the query 

άLƴŎƭǳŘŜ ǎǳōŘƛǊŜŎǘƻǊƛŜǎΚέ ǿƛǘƘ ά¸ŜǎέΦ 
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PhotoMapper Desktop 10 searches the selected folders for photos in the .jpg format. In the query that opens 

now you can decide whether you want to add the photos which were found to the Shapefile or discard the 

search. 

 

ADD WITH DRAG & DROP 

In PhotoMapper Desktop 10 it is possible to add photos from any file explorer window with drag & drop. 

In order to do this, mark one or several photos in a file explorer and drag them into the PhotoMapper Desktop 

10 window with the mouse button pressed. 
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ADDING UNREFERENCED PICTURES 

Photos without any GPS information can be referenced retroactively using PhotoMapper Desktop 10. 

DIRECTORY SELECTION 

In order to do this, click on "Add unreferenced photos" in the "File" menu. In the PhotoMapper Desktop 10 

window, the display changes to a file selection with photo preview.  

Select the folder. On the bottom left, the photos in the selected directory are displayed. 

 

  

If you want to display whether or not the photos listed in the overview are georeferenced, click on the 

Ϧ9ǾŀƭǳŀǘŜ 9·LCϦ ǎŜƭŜŎǘƛƻƴ ōƻȄ όŦƻǊ ŘƛǊŜŎǘƻǊƛŜǎ ǿƘƛŎƘ ƘŀǾŜ ŀƭǊŜŀŘȅ ōŜŜƴ ƭƻŀŘŜŘΣ ŎƭƛŎƪ ƻƴ ǘƘŜ άwŜŦǊŜǎƘέ ōǳǘǘƻƴΦ 

Now, when accessing a directory, the EXIF headers of the photos will be searched for GPS coordinates and the 

result is displayed in the "GPS-EXIF" column of the picture list. 
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In order to refresh the photo overview of a directory, click on the "Update" symbol. 

DETERMINE LOCATION OF TAKING 

1. Mark the photo to be referenced. 

2. /ƭƛŎƪ ƻƴ ǘƘŜ ά!ŘŘέ ōǳǘǘƻƴ. 

3. Now click on the location in the map where on photo was taken. PhotoMapper Desktop 10 saves 

the position data in the geodatabase. From now on, the picture is linked with this location of 

taking and is listed in the Thumbnail view as a georeferenced picture. 

Pictures with faulty position data can be corrected in an ArcGIS editing session by simply moving the location of 

ǘŀƪƛƴƎ ƻƴ ǘƘŜ ƳŀǇΦ CƻǊ ŦǳǊǘƘŜǊ ƛƴŦƻǊƳŀǘƛƻƴ ǊŜŀŘ ǇŀǊŀƎǊŀǇƘ ά{ǘŀǊǘ ŜŘƛǘƛƴƎ ǎŜǎǎƛƻƴέΦ 

Hint 

¢ƘŜ ƴŜǿ Ǉƻǎƛǘƛƻƴ Řŀǘŀ ƛǎ ƻƴƭȅ ŎƘŀƴƎŜŘ ŀƴŘ ǎŀǾŜŘ ƛƴ ǘƘŜ ƎŜƻŘŀǘŀōŀǎŜΦ ¢ƘŜ ƛƴŦƻǊƳŀǘƛƻƴ ƎƛǾŜƴ ƛƴ ǘƘŜ ǇƛŎǘǳǊŜΩǎ 

header does not change. 

Lƴ ƻǊŘŜǊ ǘƻ ŜƴŘ ǘƘŜ ƎŜƻǊŜŦŜǊŜƴŎƛƴƎΣ ŎƭƛŎƪ ƻƴ ǘƘŜ ά/ƭƻǎŜέ ōǳǘǘƻƴΦ ¢ƘŜ ƭƛǎǘ ƻŦ ǇƘƻǘƻǎ ƛƴ ǘƘŜ ŎǳǊǊŜƴǘƭȅ ǎŜƭŜŎǘed layer 

opens again. 

SETTINGS 

You can find the settings menu under Menu > Tools > Options. 
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Here you can determine which data fields from the EXIF header of your photos shall be saved in the attribute 

table of your feature class. 
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ABSOLUTE / RELATIVE PATHS 

You can save the path names belonging to the loaded photos as relative path. The advantage of this is that 

entire projects (Shape file / geodatabase + photos) can be relocated retroactively provided that the directory 

structure stays the same. 

 

Hint 

Please notice that the use of relative paths is not possible if shape file or geodatabase and the photos are on 

different  hard disks. 

{ŜƭŜŎǘ ǘƘŜ ŘŜǎƛǊŜŘ ƳƻŘŜ ƛƴ ǘƘŜ ǎŜǘǘƛƴƎǎ ǳƴŘŜǊ Ϧ9ȄǘŜƴŘŜŘ ƛƳǇƻǊǘ ǎŜǘǘƛƴƎǎέΦ 

Hint 

The changes in the settings are not retroactive, i.e. the path statements of already pasted photos are not 

adapted to the new settings. 

EMBEDDING EXIF INFORMATION 

The EXIF information can be added selectively to the attribute table of the feature class. 

The parts of EXIF information selected here are taken from the photos' headers and transferred into the 

attribute table of the feature class. 

Hint 

If the EXIF settings are changed before importing into an existing feature class, the newly selected categories 

will be added to the attribute table. Deselected categories remain in the attribute table, the values, however, 

are no longer transferred from the EXIF header. 

DISLOCATION OF PHOTOS AND MAP PROJECTION 

It may happen that the photos are not displayed in their correct position in the map. The reason for this lies 

frequently in the used coordinate systems and projections. With the wrong settings, a dislocation of about 180 

meters is typical. In this chapter, we will explain the causes and describe which settings you have to select in 

order to make map and photo fit each other exactly. 

PROJECTION, DATUM, ELLIPSOID, COORDINATE SYSTEMS 

Lƴ ƻǊŘŜǊ ǘƻ ŘƛǎǇƭŀȅ ǘƘŜ ŎǳǊǾŜŘ ŜŀǊǘƘ ǎǳǊŦŀŎŜ όάǘŜǊǊŜǎǘǊƛŀƭ ƎƭƻōŜέύ ƛƴ ŀ ƳŀǇΣ ƳŀǇ ǇǊƻƧŜŎǘƛƻƴǎ ŀǊŜ ǳǎŜŘΦ ¢ƘŜǊŜ ŀǊŜ 

numerous projections with different characteristics and for different areas of the earth surface. The real shape 

of the earth is hereby approached by a so-called ellipsoid (= mathematical description of the 3-dimensional 

earth) and the exact position of the ellipsoid defined with the so-called datum. 

Hint: Iƴ ǎƻƳŜ ŎŀǎŜǎΣ άŘŀǘǳƳέ ƛǎ ŀƭǎƻ ǳǎŜŘ ŀǎ ŀ ŎƻƭƭŜŎǘƛǾe term for ellipsoid and datum. 

Coordinate systems are used to specify an exact position in a map or on the real earth surface. 

For the illustration in a map, projected coordinate systems are used, i.e. a combination of projection (including 

ellipsoid and datum) and a coordinate system. In Germany, Gauß-Krüger is often used for instance, which 

applies DHDN (Deutsches Hauptdreiecksnetz; German Main Triangle Net). 
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COORDINATE SYSTEMS IN ARCGIS 

All layers used in a data frame are displayed in exactly one coordinate system, namely the coordinate system of 

the data frame. 

If the layers have different coordinate systems, ArcMap will convert them into the coordinate system of the 

data frame. ArcMap converts the projected coordinate systems automatically. 

If the ellipsoid/datum of a layer differs from the ellipsoid/datum of the data frame, however, a so-called datum 

transformation has to be carried out. ArcMap cannot decide autonomously which datum transformation is to 

be used. This is where you, the user, have to take action. 

DATUM TRANSFORMATION FOR POSITION CORRECTION OF THE GPS PHOTOS 

The GPS photos are taken by the Ricoh G700SE / Caplio 500SE in the coordinate system WGS 1984, which uses 

WGS 1984 as ellipsoid/datum. If you use background map in the data frame with other coordinate systems, e.g. 

Gauß-Krüger, there will be a spatial displacement of the locations of taking of about 180 meters. This is caused 

by the Gauß-Krüger coordinate system using DHDN as ellipsoid/datum. So you have to select in ArcMap which 

datum transformation should be used. 

In order to display the GPS photos correctly in the Gauß-Krüger coordinate system as well, proceed as follows: 

1. Click with the right mouse button on the data frame in the table of contents and select "attributes". 

Here you can make the settings for the entire data frame. 

2. Click on the index tab "Coordinate system". 

 

3. Select the desired coordinate system. 

For a display in the Gauß-Krüger system zone 2 follow this path: Predefined/Projected Coordinate 

Systems/ National Grids/ Germany Zone 2 
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4. /ƭƛŎƪ ƻƴ ǘƘŜ Ϧ¢ǊŀƴǎŦƻǊƳŀǘƛƻƴǎΧϦ ōǳǘǘƻƴΦ 

 

5. Select the following parameters: 

Transform from: GCS_WGS84 

into: GCS_Deutsches_Hauptdreiecksnetz 

using: DHDN_to_WGS_1984_2 

6. If you should use another system than Gauß-Krüger, modify the details in "into:" and "using". 

7. Confirm all windows with "OK". 

Now the locations of taking of the GPS photos are displayed correctly. 

PHOTO DISPLAY 

PHOTO-HOTLINK 

Activate the "Preview/Edit" tool in the PhotoMapper Desktop 10 toolbar. 

 

When you now move your cursor over the capture point of one of your photos, a preview of your photo will 

pop up and show its Filename including the memo content of the picture (works with the Ricoh G700SE / 

Caplio 500SE). 
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When you hit the capture point, the preview will show till you click with your cursor next to the capture point. 

 

 

In the case that two or more photos are located in the same capture point, you will be able to navigate in the 

preview window throught those pictures. The matching filename will be shown in first place of the file menu. 
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SYMBOLS 

PhotoMapper Desktop 10 allows you to assign symbols indicating the direction of taking to the positions of 

taking in the map. 

Just click in the menu ƻƴ ά9Řƛǘέ Ҕ ά!ŘŘ ǎȅƳōƻƭǎ ǿƛǘƘ ƛƴŘƛŎŀǘƛƻƴ ƻŦ ŘƛǊŜŎǘƛƻƴέ. Now all positions of taking of the 

selected layer are marked with a black arrow. 

DIRECTION INDICATOR 

In the EXIF header of the image, the direction in which the picture was taken can be saved. It can be registered 

by the GPS device in two different ways: 

1. Using a GPS receiver with an integrated digital compass: 

In this case, the direction of taking is registered by the digital compass, communicated to the camera 

and saved in the moment the picture is taken in the header. The direction of taking is indicated in 

degrees. North corresponds to 0°, East to 90°, South to 180° and West to 270°. 

The GPS camera Ricoh G700SE / Caplio 500SE is available with an integrated compass and GPS 

receiver. 

2. Using an ordinary GPS receiver: 

With a GPS receiver, the direction of taking can be construed from the last registered position data. 

The photographer has to make sure that the moving direction shortly before the taking is the same as 

the direction of sight. The change in position should be at least 3 meters. 

With the "Display direction settings" you can adapt the direction information to be used to your recording 

device. The "automatically" setting checks, where there is a compass value. As the Exif field does not accept 

any empty fields, we assume that no compass was used if the value is "0". In the rare case that a picture has 

been taken exactly in Northern direction, there may be an error at this place. To exclude that case, please 
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choose the corresponding entry from the menu. But the direction of taking can be corrected using the software 

functionality of the PhotoMapper Desktop 10, see paragraph "Orientate". 

 

ORIENTATE 

²ƛǘƘ ǘƘŜ άhǊƛŜƴǘŀǘŜέ ŦǳƴŎǘƛƻƴ ȅƻǳ Ŏŀƴ ŎƘŀƴƎŜ ǘƘŜ ŘƛǊŜŎǘƛƻƴ ƻŦ ǾƛŜǿ ŀǘ ǘƘŜ ƭƻŎŀǘƛƻƴ ƻŦ ǘŀƪƛƴƎ ƛƴ ǘƘŜ ƳŀǇΦ 

1. Activate the "Preview/Edit" tool in the PhotoMapper Desktop 10 toolbar. 

 

2. Select the photo you would like to edit by clicking on its location of taking in the map. Or mark the 

photo in the PhotoMapper Desktop 10 window. The location of taking will be highlighted in the map 

with a green dot. 

3. Right-click on any part of the map or select "Modify direction" from the menu. 

 

4. Now a compass is displayed over the point where the photo was taken. Edit the direction of sight by 

clicking on the compass and drag the compass needle to the desired direction with the mouse button 

kept pressed. Alternatively, you can use the control bar under the compass for the setting. 
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5. Confirm the direction of sight with "OK" or if you would like to discard the modification, cancel by 

clicking on "Close". 

You can repeat this process anytime, thus correcting the direction of sight. 

ADD PHOTOS TO THE MAP 

Just like in the previous version, you can add photos to the map as annotation. Either all or just individual 

pictures are added to the map content. 

¶ In order to add all photos of the selected layer as annotation to the map, select "Edit" > "Add photos 

as annotations" from the menu in the PhotoMapper Desktop 10 window. 

¶ There are two ways of adding individual pictures: 

o Right-click on the desired photo in the PhotoMapper Desktop 10 window. Select "Add as 

annotation" from the menu. 

 

o The second way is marking the photo directly in the map at the location of taking using the 

"Preview/Edit" tool. Right-click on the location of taking and select "Add as annotation". 
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You can also move the added photos later, or change the size. You find information on this subject in paragraph 

"Edit photos". 

VIEW 

PhotoMapper Desktop 10 offers two different views for the management of your photos: a thumbnail and a list 

view. 

You can choose between these two possibilities in the PhotoMapper Desktop 10 window by selecting the menu 

item "View". 

 

CONTEXT MENU 

If you right-click on a photo in the PhotoMapper Desktop 10 window, a menu with the photo management 

functions will open. 
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The following functions are available: 

¶ Open: Opens the photo with the standard application you have defined. 

¶ Pan to: Centers the selected photo maintaining the zoom level. 

¶ Zoom to: Zooms in on the location of taking of the selected photo. 

¶ Identify: Displays information concerning the picture entry in the layer. 

¶ Add as annotation: Adds the picture to the map, see paragraph "Add photos to the map". 

¶ Delete: Erases the photo from the layer. 

PDF PHOTO-REPORT 

 

 

The PDF Photo Report tool gives you the possibility of exporting selected photos as PDF files. This is facilitated 

by the comfortable Wizard functionality. 






























